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重重要要事事項項  ::  在在開開始始使使用用本本軟軟件件前前，，請請先先閱閱讀讀以以下下條條文文  

  

重要事項 : 在開始使用本軟件前，請先閱讀以下條文 
 
多謝閣下選購適馬產品。 
 
為令閣下能夠享受到本產品所提供之最佳效能；而不會導致任何損壞和受傷；請務必在使
用本產品前，小心閱讀本用戶手冊。 
 
通告 

• 在未獲得批准前，請勿以任何方式，另行編輯此手冊之全部或部份內容。 

• 此手冊之內容，如有修改；將不會另行通知。 

• 雖然本公司已經儘一切可能性準確地編輯本手冊；但如閣下遇到任何錯誤，請儘速聯絡
本公司之客戶服務部。而任何錯誤損失，本公司概不負責。 

• 本產品之規格附件，如有修改；將不會另行通知。 

• 凡此軟件之操作所招致之任何結果，適馬及其有關之註冊公司均概不負責。 

 
為免導致任何損壞和受傷；請務必在使用本產品前，小心閱讀以下條文。 
 

警告 !! 
如忽視此警告標誌，在使用本產品時可能會導致嚴重受傷

或危險結果。 
 
警告 !! 

 
請不要將本產品內附之光碟放在音頻光碟播放器內。如使用本產品內附之光碟放在 
音樂光碟播放器內，並利用耳筒聆聽，可能令聽力受損。而使用本產品內附之光碟放在音

樂光碟播放器內，亦可能令喇叭損壞。 

 
請閣下嚴謹地使用本數碼相機拍攝照片，請勿使用任何方式以觸犯國際及本地版權法例及
規條。另外，本產品純供個人拍攝用途。在攝影陳列、論証示範、商業性展覽時，必需遵
守其版權及法定權上的守則。 
 

版權注釋 

§ FOVEON為 Foveon, Inc公司的注冊商標，而X3和 X3標誌均為Foveon, Inc.  商標。 
§ CompactFlash 為 SanDisk Corporation 的註冊商標。 
§ IBM PC/AT 系列電腦和  Microdrive是在美國的 International Business Machines Corporation 

(IBM) 之商標或註冊商標。 
§ Microsoft 和 Windows 是在美國和其他國家的 Microsoft Corporation 之注冊商標或商標。 
§ Macintosh 和 FireWire 是在美國和其他國家的Apple Computer Inc. 之注冊商標。 
§ Adobe 和 Photoshop 均為 Adobe Systems Incorporated 之註冊商標。 
§ 本手冊內所述之其他公司和產品的名稱均為它們公司或相關公司的商標或註冊商標持有
者。 
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11   用用 戶戶 手手 冊冊 簡簡 介介   

 

在此章節中，你會學到 … 
 
 

• Sigma Photo Pro 的主要特性。 

 
 

• 如何使用此本用戶手冊。 
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11..11  關關於於  SSIIGGMM AA  PPhhoottoo  PPrroo      

你可以利用 SIGMA Photo Pro 作什麼用途 ? 歡迎光臨快速虛擬旅程  ! 

以下是 SIGMA Photo Pro的不同視窗和調色板。 請按入任何視窗和調色板， 便可以跳到詳細解說
的畫面裡。 
 

 
  

  

 

  

 

 
主視窗 

• 由數碼相機裡複製圖像到你的電腦中。 
• 將圖像轉換成 TIFF 或 JPEG。 
• 可在電腦和數碼相機內，將圖像加入符號、
鎖定、旋轉及刪除。 

 

圖像資料視窗

• 檢視拍攝資料。 
• 檢視圖像資料。 
 

修正控制調色板 
• 修改圖像的曝光補償、對比度、陰影、覆蓋和色
彩飽和度。 

• 色彩修正。 
• 將用戶自行修正的設定，使用載入、儲存和刪除
等功能。 

• 檢視矩形圖。 
• 設定覆蓋及陰影提示訊息。 
 

 

檢視視窗 

• 以較大尺碼檢視圖像。  
• 選擇圖像修正模式。 
• 圖像儲存。 
• 放大詳細資料。 
• 檢視覆蓋及陰影提示訊息。 
• 將圖像加入標記、鎖定、旋轉及
刪除。 

• 可將圖像自由在主視窗中顯示。 
• 動[態修正模式。 
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主視窗之原件  

以下是主視窗的關鍵原件。請按入捷徑，便可觀看詳細說明。 
 
 
 

 

按上 資料按鈕 p. 41  

開啟圖像資料視窗。 

按上Copy Camera Images  按鈕  p. 14  可將
X3F 圖像由數碼相機複製到電腦中。 

 數碼相機方框  p. 11 可顯示數碼相機的連接狀態。 點
上數碼相機方框內任何一處，便可檢視數碼相 機內

的圖像，並以預視圖片方式顯示。 

 

按上 Save Images As 按鈕  p. 28 將
X3F 圖像 儲存成為TIFF 或 JPEG 

檔案模式。 
 

使用 編輯按鈕  p. 20 可選用: 

旋轉、標記、鎖定、刪除或

檢視附加資料。 

按上 Review Images 按鈕  p. 22  

開啟檢視視窗，以較大尺碼檢視

及修改圖像。 

 

 電腦方框  p. 17 可顯示電腦內的硬盤和資料夾。
點上電腦方 內任何一處，便可檢視數碼相 機內

的圖像，並以預視圖片方式顯示。 

使用 預視圖片按鈕  p. 18  控
制預視圖片的尺碼和款式。 

預視方框  p. 18  顯示在數碼相機和電腦
資料夾內的圖像。 
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檢視視窗之原件 

以下是檢視視窗的關鍵原件。請按入捷徑，便可觀看詳細說明。 

按上 瀏覽按鈕 p. 23 控制檢視 
圖像的前後方向。 
 

按上 Save Image As  按鈕  p. 29 
處理X3F 圖像並儲存成為TIFF 或 

JPEG 檔案模式。 

按上  
資料按鈕  

  p. 41 開啟
圖像資料

視窗。 

使用 編輯按鈕  p. 20 可選
用: 旋轉、標記、鎖定、

刪除以修正檢視圖像。 

修正模式 p. 25 容許檢視圖像時 
應用或不用此修正模式。 

 

按上 Adjustment Controls  p. 32 開

啟修正操控調色板。 

 

使用 局部放大按鈕  p. 23 
可檢視局部圖像資料。 
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  11..22  關關於於用用戶戶手手冊冊   

此用戶手冊主要是向各 SIGMA Photo Pro使用者提供有關安裝和使用此軟件的資料。 
而 SIGMA Photo Pro為 SD-9的專用軟件。 
 
 

符號圖像之代表意義 

 
• 選單的路徑如下: 

 Menu Header > Menu Choice 
 

• 鍵盤捷徑指示如下: 

Ctrl  或 Cmd  + 字母 或 符號 
 
“Ctrl” 是個人電腦鍵盤上 “Control” 鍵；而 “Cmd” 是麥金塔電腦鍵盤上 “Common” 鍵。 

 

畫面瀏覽式的用戶手冊 

當用戶使用 SIGMA Photo Pro 時，如需要協助，請於 SIGMA Photo Pro內任何視窗選擇說明選單 
(Help)。 
 
以下是以 “PDF” 檔案模式 的畫面瀏覽型用戶手冊，目的是方便用戶能更快速地瀏覽和尋找。 
 

 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

 
 
 
 

使用書籤模式搜尋 
各種主題目 

利用搜尋功能，以尋找 
關鍵字眼。 
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22   軟軟 件件 安安 裝裝 程程 序序   

  

  

  

  

 

在此章節中，你會學到 … 
 

 
• 如何在電腦安裝Sigma Photo Pro 。

 

• 如何調整你的監視器。 
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22..11  在在個個人人電電腦腦上上安安裝裝軟軟件件  

個人電腦的系統資源需求  

如要在你的個人電腦上使用 SD9數碼相機和 SIGM A Photo Pro，請參考以下系統資源的最低需求。 
 

•  Pentium II 233MHz 或以上 
• Windows 98 Second Edition, Windows 2000, Windows ME, Windows XP 
• 256MB RAM 
• 40 MB 硬盤 
• 16-bit  顯示卡。 (建議使用 24-bit) 
• 800x600 或以上的顯示器解像度。(建議使用1024x768 解像度)  
• USB or IEEE 1394 (FireWire™™) 連接插口。 
• 光碟機 

 

麥金塔電腦的系統資源要求 

如在你的麥金塔電腦上使用 SD9 數碼相機和 SIGMA Photo Pro，請參考以下系統資源的最低需求。 
 

• PowerPC G3 Processor 
• Mac OS 9, Mac OS X v10.1 
• 256MB RAM 
• 40 MB 硬盤 
• 16-bit  顯示卡。 (建議使用 24-bit) 
• 800x600 或以上的顯示器解像度。(建議使用1024x768 解像度) 
• USB or IEEE 1394 (FireWire™™) 連接插口 
• 光碟機 
 
 

安裝和移除 SIGMA Photo Pro 

如要在電腦上安裝 SIGMA Photo Pro，請插入 SD9附送之安裝光碟。 然後在安裝光碟內雙按 
“Setup” (視窗系統) 或 “Installer” (麥金塔系統) 以安裝軟件。 
 

歡迎畫面會顯現在你的面前。 
 
精靈會帶引你以不同的語言，逐步安裝SIGMA Photo 
Pro 在指定的資料夾內。 
 
在安裝 SIGMA Photo Pro前，請關閉所有其他軟件。而
在安裝後，請重新開機。 
 
如你想移除 SIGMA Photo Pro，請在視窗的 “開始” -> 
“程式集” -> “SIGMA” 欄內，選擇 “Uninstall” 或 請到
控制台 -> 選擇 “新增 / 移除程式”；然後移除此程式 。 
  

如你想在麥金塔電腦上移除SIGMA Photo Pro， 請在SIGMA Photo Pro的資料夾中用雙按 
“Uninstaller” 圖示。 
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安裝數碼相機的驅動程式 
SIGMA Photo Pro 須為SD9數碼相機準備一驅動程式以作為連接之用。在麥金塔電腦上，這驅動程
式已經自動在安裝程序中完成。 在視窗系統上 ，要完成安裝驅動程式程序，需要使用硬體精靈。 

1) 請驗明數碼相機已經關閉。 

2) 將 IEEE 1394 (FireWire™) 接線 或 USB 接線連接上你的個人電腦和數碼相機之背部。 

3) 開啟數碼相機，並等待啟動電腦的硬體安裝精靈。 

4) 請跟隨硬體安裝精靈的指示。如 SIGMA Photo Pro已經安裝，但精靈詢問驅動程式的位
置，請參考以下的路徑: 

C:\Program Files\SIGMA\Photo Pro\Drivers 

 在安裝過程中，你可能需要多次重申驅動程式的位置。 

5) 當指定驅動程式的位置後，要完成安裝精靈，請按上  “Finish” 。 

 

無論使用USB 或 IEEE 1394 (FireWire™)，皆請參考以上的安裝程序。 

請勿同時使用 USB 和 IEEE 1394 (FireWire™) 連接。請任選其一。 
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22..22  顯顯示示器器設設定定   

檢查顯示器的  光暗度  (brightness)、加瑪值 (gamma) 和 色彩度  (color) 

請將顯示器的色彩度與圖像原色儘量調節一致。如顯示器之性能暫未能符合要求，請定期檢查顯示
器的表現，及參考顯示器廠商所提供的使用手冊。 
 
用戶可使用 SIGMA Photo Pro 內的顯示器確認(Monitor Verification) 以調整顯示器的輸出。 
 
在主視窗裡選取 “Tools” -> “Monitor Verification”。 
 
以下的圖表只是用作確認 色彩度 (color) 和 加瑪值 (gamma) 的參考。請使用顯示器上的控制台和參
考顯示器廠商所提供的使用手冊以作出適當的調整。 

 

使用顯示器預設設定 

SIGMA Photo Pro 支援顯示器
預設設定。如需要顯示器資

料，請參閱顯示器廠商所提供

之使用手冊、調節顯示器設定

之軟件或系統指引。 

 

選擇符合顯示器尺碼的最佳解

像度 

SIGMA Photo Pro 的最佳畫面
解像度是 800x600, 但在檢視
圖像和使用預視功能時皆可使
用較大的畫面解像度

1024x768 或其他尺寸的解像
度；以較彈性地檢視圖像。  
你亦可以更改主視窗、檢視視

窗和預視視窗的尺寸及在畫面

上自由移動不同位置。 
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33   開開 始始 前前 的的 準準 備備

 

在此章節中，你會學到 … 
 

• 如何將數碼相機連接上你的電腦。
 

• 如何開始使用SIGMA Photo Pro 
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33..11  將將數數碼碼相相機機連連接接上上你你的的個個人人電電腦腦   

當使用 SIGMA Photo Pro 時，只有一部 SD9 數碼相機 可以連接上電腦。為使軟件能正常運作，
請不要在同一時間連接其他數碼相機。 
 

接線連接 

要將數碼相機連接上電腦，請使用 USB 接線或 IEEE 1394 (FireWire™) 接線；及將數碼相機關
閉。請勿將數碼相機同時連接 USB 和 IEEE 1394 (FireWire™)。 
 

開啟數碼相機 

開啟數碼相機的方法，請參閱用戶手冊。除非數碼相機在連接電腦後開啟，否則 SIGMA Photo 
Pro 是不會偵測到數碼相機的。 
 
如數碼相機是第一次連接上電腦，安裝驅動程式程序會自動啟動。完成後將不會再出現。 
 
當數碼相機開啟及連接上電腦，SIGMA Photo Pro 會自動啟動。藍色的數碼相機方框會出現於
主視窗的右方。於數碼相機的 CF記憶卡內圖像會自動顯示在預視視窗上。 如數碼相機並無圖
像檔案，便不會有圖像顯示在預視視窗內。 

 
 
 
 

 

 

 

 

 

 

 

 

電源轉換 (電池 ß à AC電源) 

建議當數碼相機連接上電腦時使用 AC電源。因為使用 AC電源時會節省電池用量，並且在圖
像轉移時避免因電量不足，而造成不必要的損壞。 
  

 
當數碼相機轉用 AC電源時，AC電源圖示會自
動轉為電池圖示。 
 
當使用電池時，電池圖示會定時轉變為紅色，作

為提示電池正在使用中。因此並不需要有低電量

提示。 

 

 

當使用軟件時，要連接數碼相機 …… 

當使用 SIGMA Photo Pro 時，要連接數碼相機，在其中之圖像是不會自動在主視窗內顯示。如
要顯示數碼相機內的圖像，請選擇數碼相機方框。  

記憶卡圖示會指示數碼

相機和CF卡正在連接

中。 

 

充電池圖示指示 
剩餘電量。 
 

藍色橫條會指示數碼相機

內的圖像，並顯示在預視

視窗內。 
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33..22  軟軟件件啟啟動動   

開啟和關閉 SIGMA Photo Pro 

當數碼相機被連接上電腦及開啟時，SIGMA Photo Pro 會自動被啟動。同時主視窗和數碼相機
方框會同時出現。如圖像沒有在預視視窗上顯示，而數碼相機內又確實有圖像的話；可能電腦

未能與數碼相機連接上。 
 

你可以直接在畫面上“雙按” 右側的圖示，啟動 SIGMA Photo Pro，而不必
連接數碼相機。主視窗會出現，而在上次登出前所使用的資料夾，亦會顯

現在電腦方框。任何 X3F、JPEG或 TIFF 的圖像檔案都可顯示在本軟件
中。如你是第一次使用 SIGMA Photo Pro，是不需選擇資料夾。 
 
如要登出本軟件，請在主視窗上的選單裡，按上 “Close”；或在主視窗的選
單中選擇  
File -> Exit 。 

 

使用和取消自動執行模式 

當 SD9數碼相機開啟及連接上電腦，SIGMA Photo Pro 的預設是會自動執行軟件。但如你不想
使用此模式，你可以使用 “取消”自動執行模式功能。請到主視窗選單上選擇  
Camera -> Auto-Launch Setting 。 
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44   圖圖 像像 轉轉 移移

 

在此章節中，你會學到 … 
 

• 如何將圖像由數碼相機複製到電腦。 
 

• 如何在CF記憶卡中刪除已複製圖像。 
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44..11  將將圖圖像像由由數數碼碼相相機機複複製製到到個個人人電電腦腦  

  

 

使用 “Copy Camera Images” 按鈕 

將圖像由數碼相機轉移到電腦上的資料夾內，電腦是會將圖像儲存成為X3F 檔案。而且由CF記憶
卡被複製到電腦的圖像，亦已被辨認和標籤。這項功能的好處，是可以令用戶分辨出哪個圖像在數

碼相機中已經被複製到電腦；從而可讓用戶刪除舊圖像，以節省記憶卡空間。 
 
將 X3F圖像檔案，由數碼相機轉移到電腦上的步驟如下:  

1) 連接及開啟數碼相機 
2) 在主視窗瀏覽方框內，請選擇 “Camera” 
3) 如只要轉移某部份圖像，請利用 選取(select) 或 標記(mark) 

(圖像在數碼相機內會被標籤，也會顯示在 SIGMA Photo Pro。) 
4) 請按入 “Copy Camera Images” 按鈕。 

 
對話匣會出現如下: 
 

  
 

使用 CF記憶卡閱讀器複製圖像到電腦 

如你使用CF記憶卡閱讀器；SIGMA Photo Pro 也能辨認記憶卡內的圖像檔案，並顯示在瀏覽方框
內。而圖像也可以由記憶卡被轉移到電腦上的資料夾內，但X3F檔案卻不會被標記成為已轉移圖
片。

按上 “OK”  便開始轉移； 按上“Cancel” 便
返回主視窗。 

 

來源地(Source):  
選擇性地按上比例按鈕、標籤或已選擇的圖
像；可用不同型式轉移圖像。 

 

轉移選項(Transfer Option): 
如在方格內按入 P 號 ；表示當圖像由數碼相機轉移
到電腦後，便會從CF記憶卡內刪除。 

 

目的地(Destination): 
按上 “Choose” 按鈕，可選擇目的地以儲存 X3F 
圖像檔案。 
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55   圖圖 像像 管管 理理

 

在此章節中，你會學到 … 
 
 

• 如何顯示、檢視和分類圖像。 
 

• 如何選擇和移動圖像。 
 

• 如何重新命名圖像。 
 
• 如何標記、鎖定和旋轉圖像。 
 

• 如何刪除圖像。 
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55..11  主主視視窗窗概概覽覽   

主要功能 

主視窗的各種功能如下: 

• 由數碼相機複製圖像到個人電腦 

• 利用預視圖框檢視圖像 
• 處理和儲存圖像群組 
• 複製和移動圖像到新資料夾 
• 旋轉、標記或鎖定圖像 
• 重新命名或刪除圖像 
• 存取圖像資料視窗 
• 在檢視視窗開啟圖像 

 
當你選用數碼相機方框或選用電腦方框時，圖像會在預視視窗直接顯示；而且被選擇的方框會改變

為藍色。 
 
當啟動 SIGMA Photo Pro 時，主視窗也會同時開啟。 如要登出軟件，請關閉所有視窗和方框。 
 
 

其他資訊連接  

按入以下各項捷徑，可檢視主視窗各原件的詳細描述。 
 

 
 
  

  

  

 

由數碼相機複製圖像 

處理和儲存圖像 

圖像資料 

旋轉、標記或鎖定圖像 

刪除 

開啟檢視視窗 

更改預視外觀型式 

 
數碼相機

方框 
 
 
 
 
電腦方框 

預視方框

主視窗 
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更改主視窗的尺碼 

可使用選單上的按鈕，以放大、縮小和回復主視窗的尺碼。而亦可以拖曳視窗右下角的標誌， 
以改變視窗的大小尺碼。  

 

更改瀏覽和預視方框 

如要更改瀏覽和預視方框的尺寸，可按著和拖曳兩個方框之間的間隔條。 
 當下一次再開啟SIGMA Photo Pro時，是會記著此新增的變改。  

  

  

  

  

  

  

  

  

  

55..22  在在主主視視窗窗顯顯示示圖圖像像  

 

 

 

檢視數碼相機內的圖像 

按入數碼相機方框可顯示圖像群。 如指著數碼相機方框選單，數
碼相機內的圖像群會被顯示在預視方框上。 
 

檢視個人電腦內的圖像 

按入電腦方框可顯示上一次的資料夾。電腦資料夾內的圖像群會

被顯示在預視方框上。  
 
註: 如上一次的資料夾被偵測到，電腦方框會被指著，但並無資
料夾被顯示。 
 
按入已選擇的硬盤或資料夾，便可以灰色條棒選取需要的 
資料夾。 
 
雙按那資料夾，便可開啟和顯示副資料夾。 
 
註: 如預視方框並無顯示圖像，這說明數碼相機內是無 X3F 圖像
檔案，或並無TIFF、JPEG和 X3F在所選擇的資料夾內。 
 

 
 
 

如用戶要改變預視面版等之寬度尺寸， 
請左右移動灰色直邊。 
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55..33  觀觀看看預預視視圖圖片片的的不不同同方方式式   

更改預視圖片的尺碼和款式 

 
按上在主視窗底部的預視按鈕，以不同的尺碼和有或無文字方式檢視預視圖片。 
 
 

小型預視 

在主視窗選單中按上此按鈕 或 選擇 View -> Small Thumbnails  。 

中型預視 

在主視窗選單中按上此按鈕 或 選擇 View > Medium Thumbnails 。 

大型預視 

在主視窗選單中按上此按鈕 或 選擇 View > Large Thumbnails 。 

小型預視附上詳細資料 

在主視窗選單中按上此按鈕 或 選擇 View > Thumbnails with Details 。 

 

 

 

 

  

分類和過濾預視圖片 

在主視窗選單中可選擇分類和過濾功能，以作預視之用。 除利用選單外，也可使用相關鍵盤字鍵
在預視方框，選擇不同的預視組別。 

 
 
 
 
 在硬盤或資料夾內，只顯視X3F圖像檔案。 

(並不會顯示TIFF 和 JPEG 圖像檔案) 

過濾性地選擇已標籤或鎖定的圖像。 

根據不同的款式，在預視方框內將圖
像依指定型式掛列。 

在預視方框內使圖像相反掛列或將其重新整理。 
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55..44  將將圖圖像像重重新新命命名名   

在 SIGMA Photo Pro以外重新命名  

如你在 CF記憶卡內更改X3F 圖像檔案的名稱 (IMG#####)，被更改的圖像是不能在數碼相機內閱
覽的。但如將X3F 圖像檔案複製到電腦內，便可以被閱覽了。  
 
在電腦上，如你在 SIGMA Photo Pro外將檔案的延伸重新命名；本軟件仍然可以辨認此圖像檔案 
(.X3F)。但其他兩類檔案延伸 TIF 和 JPG 就不能更改。 
 

 
55..55  選選取取和和移移動動圖圖像像   

選擇單一圖像  

在預視方框，按上一幅圖像。 雙按那已被選擇的圖像，便會在檢視視窗顯示出來。 
 

選取多幅圖像  

請參考以下程序，利用滑鼠在預視方框 “選取”或 “不選取” 圖像。 
 
• Shift + Click  : 在預視方框內以連續方式選取圖像。  
• Ctrl/Cmd + Click: 在預視方框內以隨意方式選取圖像。 
• Ctrl/Cmd + A: 選取預視方框內所有圖像。 
• 按在版面空白位置 或Ctrl/Cmd + D :  解除選取預視方框內所有圖像 或 使用 Click  放在空置的空
間上，也有同一效果。 

• Ctrl/Cmd + Shift + I   : 在預視方框內以翻轉型式選取圖像。 
 
 
以下是在預視方框，以選單方式和鍵盤捷徑方式，選擇 “選取”、“解除選取”、“剪下” 、“複製” 和  
“貼上” : 
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55..66  在在主主視視窗窗及及檢檢視視視視窗窗內內，，將將圖圖像像標標記記、、鎖鎖定定和和旋旋轉轉   

 

 
 

圖像旋轉 

在預視方框內，使用旋轉按鈕，令圖像改變成為垂直或水平方向。在數碼相機內旋
轉圖像後；那圖像會保持已旋轉後的狀態，被複製到電腦。.  
 

• 當選擇圖像，並按上左旋轉按鈕，便可將圖像旋轉至左方。 
• 如按上右旋轉按鈕，便可將圖像旋轉至右方。 
• 只有X3F 圖像可以被旋轉。 

圖像標記和解除標記 

在數碼相機內，如你需要轉移、複製、處理或移動圖像，請使用圖像標記；當被標記之圖

像被複製到電腦後，圖像仍然維持被標記狀態。  
 

• 請選擇單一或多個圖像，按上 Mark 按鈕以標記圖像。 
• 請選擇單一或多個圖像，按上 Mark 按鈕以將圖像的標記解除。 
• 如一組圖像群被使用標記或解除標記；其他圖像也會被標記。 
• 如所有圖像被標記，再按上 Mark 按鈕，便會將圖像的標記解除。 
• 只有X3F 圖像可以被標記。 

圖像鎖定和解除鎖定 

鎖定圖像功能可以防止圖像被意外刪除。當被鎖定之圖像被複製到電腦後，圖像仍然維

持被鎖定狀態。  
 

• 請選擇單一或多個圖像，按上 Lock  按鈕可鎖定圖像。 
• 請選擇單一或多個圖像，按上 Lock  按鈕可將圖像鎖定解除。 
• 如一組圖像群被使用鎖定或解除鎖定；其他圖像也會被鎖定。 
• 如所有圖像被鎖定，再按上 Lock  按鈕，便會將圖像的鎖定解除。 
• JPEG、TIFF和 X3F圖像皆可以被鎖定。 
 
55..77  在在主主視視窗窗及及檢檢視視視視窗窗內內，，將將圖圖像像刪刪除除   

圖像刪除 

 
 
 

• 請選擇圖像，按上 Delete 按鈕 或 利用鍵盤上的 “Delete” 鍵。 
• 會有一個刪除的對話匣，指引你完成整個刪除程序。 
• 如要刪除已鎖定之圖像，請先將圖像鎖定解除。 
• JPEG、TIFF和 X3F圖像皆可以被刪除。 
• 在資源回收筒中，被刪除之圖像容許被回復。 
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66   圖圖 像像 檢檢 視視

 

在此章節中，你會學到 … 
 
 

• 如何開啟檢視視窗。 
 

• 如何在檢視視窗內檢視不同圖像。 
 

• 如何使用放大鏡檢視圖像資料。 
 
• 如何以圖層功能檢查陰影和覆蓋。 
 

• 如何使用修改模式。 
 

• 如何顯示多重檢視視窗。 
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66..11  檢檢視視視視窗窗  

開啟檢視視窗  

 
  

如要顯示檢視視窗；請雙按預視圖片，或在主視窗中選取圖像，然後按上 “Review Image” 按鈕。  
 

主要功能 

檢視視窗的各種功能如下: 
 

• 以大型尺碼及高解像度，檢視個別圖像。 
• 處理和儲存個別圖像。 
• 檢視圖像，並附上不同的修改設定。 
• 度身處理存取修改控制。 
• 圖像標記、鎖定、旋轉或刪除。 
• 可以在數碼相機內或被選取的資料夾中，瀏覽其他圖像。 
• 圖像資料視窗的存取。 

 

其他資訊連接  

按入以下各項捷徑，可觀看檢視視窗各原件的詳細描述。 
 
       

  

  自定修改 

處理和儲存圖像 
 

圖像資料 

圖像旋轉、標記和鎖定 

刪除 

檢視圖像，並附上不同的修改 

檢視視窗

放大鏡

檢視其他圖像 
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66..22  經經資資料料夾夾使使用用檢檢視視視視窗窗瀏瀏覽覽圖圖像像  

在檢視視窗選取及顯示不同圖像  

當開啟檢視視窗時，會顯示首個預視圖片。在主視窗中雙按任何預視圖片；或在檢視視窗上，選取
一幅預視圖片，並按上 “Review Images” 按鈕可替換圖像。  
 

使用瀏覽按鈕以選取圖像  

按上在檢視視窗上的瀏覽按鈕 (或可用鍵盤上的左右箭頭鍵) 以循環形式檢
視在主視窗內的預視圖片。你也可在檢視視窗的選單上，選擇 View -> Next 
image 或 Previous image 。 
 

當 Previous 按鈕轉成灰色時，即是這幅圖像已是在資料夾內的首幅圖像。當Next 按鈕轉成灰色
時，即是這幅圖像已是在資料夾內的最後一幅圖像。  
 
在主視窗內，無論何時轉換任何資料夾，在你由新資料夾將圖像替換到檢視視窗內前，瀏覽按鈕的
左右箭頭皆將不能使用。 

 

在主視窗內選取指定圖像  

如要在主視窗檢視指定圖像；即是你已開啟了檢視視窗，於主視

窗內雙按預視圖片，此圖片便會在檢視視窗替換成為新圖像。 
 
  

  

  

  

  

              

66..33  使使用用倍倍增增放放大大鏡鏡   

開啟和關閉放大鏡  

按上 倍增放大鏡按鈕，可改變放大鏡的點位。將放大鏡放置在
圖片上某部份，便可局部放大。如要取消功能，請再按放大鏡

按鈕。  
 

更改倍增放大鏡 

在檢視視窗內，此放大鏡的倍增功能可以去到 800%. 要改變倍
增率，請按上倍增放大鏡按鈕的左或右箭頭。倍增率會顯示在

左右箭頭之間。  
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如何在放大鏡上閱覽 RGB 數值 

 
會有 3組數字顯示在放大圖的右下角上，同時在放大圖像上一個大約 5 X 
5像素的方格，可反映紅、綠和藍的數值。 
 
 
 
 
 

 

回復放大鏡 

如 顯示了 “色彩修改點滴器”，倍增放大鏡便可回復；在修改控
制調色板上，按入 “色彩修改點滴器” 按鈕；無論是放大鏡或指
示點，數值指標也會復原返回以前狀態。  
 
如正顯示指示點；在檢視視窗，按上倍增放大鏡按鈕，放大功
能便可使用。 
 
  

  

66..44  檢檢視視附附上上覆覆蓋蓋和和陰陰影影的的圖圖像像  

使用遮蓋功能分析覆蓋和陰影 

如 “紅色” 代表覆蓋範圍的數值超出指標，在修正控制調色板上的矩形圖中會反映出來。 
同時，“藍色” 代表陰影範圍的數值比較指標數值為低，也會在修正控制調色板上反映出來。 
請參考 章節 8.4 ， 該段落可以提供多一點有關 “覆蓋” 和 “陰影” 等範圍提示的資料。 
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66..55  使使用用修修改改模模式式設設定定  

使用 “修改模式設定” 可以處理X3F 圖像。 當 X3F 圖像首次在檢視視窗內開啟，便會顯示 
預視圖像。 

 
當正在處理圖像時，活動指標會出現在檢視視窗的右上方的角落。當指標活

動停止後，圖像會被更新至較高品質，並在現有的修改模式中反映出來。 
 
選擇不同模式，將藍球拖曳到其他修改模；或按上適當的模式。 

 

預設模式: 以預設修改模式檢視圖像  (符合數碼相機內的預視形式) 

如選用預設模式，所有儲存在 SD9數碼相機的圖像，皆會顯
示在檢視視窗內。並且沒有進一步的色澤比例或色彩的修
改。  
 
預設模式會維持狀態，直至選取其他模式；或利用修正控制

以手動調整設定。 
 
 

自動模式: 以自動修改模式檢視圖像  (視乎圖像內容而定 ) 

如選用自動模式，每幅圖像的設定，皆被自動修正，並會顯

示出來。  
 
自動模式會維持狀態，直至選取其他模式；或利用修正控制
以手動調整設定。 
 

 
如要看自動修改做了什麼的話，可以閱覽 “修正控制”。 在自動模式中，每幅圖像都被自動 
化控制。如你想進一步修改自動設定，可將 “修正調色板” 加以更新；而自動模式會被轉變成  
“自定模式”。 
 

自定模式: 以特別自定模式檢視圖像  

如選用自定模式，每幅圖像皆會顯示在檢視視窗內。並且 
會在自動選單上顯示 “自定設定列表”；或顯示未被儲存之 
設定。  
 
直至由自動選單上選取其他模式，自定模式會維持狀態； 
或利用修正控制 使用手動調整設定。 

 
在選擇其他模式後，上一次的自定設定亦會顯示在自動選單上。而你可以利用自定模式再次修改設

定。 
 

未被儲存的設定 

當 “Current Unsaved Setting” 顯示在自動選單上時，在修正控制會顯示現存的修改設定。  
 
 如你使用修正控制，以手動型式修改圖像的話； “未被儲存的設定” 便會在任何時間出現在自動選
單上。移動控制器或滑動器自動轉換成為自定模式。 
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66..66  多多重重檢檢視視視視窗窗  

開啟多重檢視視窗  

利用多重檢視視窗，能夠令你可以將圖像和其設定作出比較。如需要顯示額外的檢視視窗，請在主
視窗和檢視視窗的選單，選擇 File -> Open New Review Window 。 
 
當開啟了多重檢視視窗；請在主視窗，雙按任何預視圖片；圖像便會顯示在最高那個檢視視窗上。 
 
註: 每個檢視視窗都需會佔用電腦記憶體；因此，當開啟多重檢視視窗，皆會令軟件運行轉慢。 
故此，要軟件有較佳表現；如無必要，請關閉檢視視窗。 
 

使用多重檢視視窗作圖像比較 

在兩個檢視視窗內顯示一些差不多的圖像，容許用戶在決定儲存圖像之前，作出詳細比較；例如: 
圖像的組合、表面層次或 焦點等。  
 

使用多重檢視視窗的圖像比較模式 

每個檢視視窗都會保留自己的修正模式； 在檢視視窗處理圖像時，每個圖像都會保留自己的修正
模式。在兩個檢視視窗內顯示一些差不多的圖像，容許用戶使用不同模式對圖像作比較。 
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77   圖圖 像像 處處 理理 和和 儲儲 存存

 

在此章節中，你會學到 … 
 
 

• 如何處理和儲存圖像。 
 

• 如何應用修改。 
 

• 如何圖像處理中，選擇解像度、檔案類型和
色彩空間等。 
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77..11  在在主主視視窗窗處處理理圖圖像像  

同時處理圖像群組  

以組別方式，處理圖像群組；好處是不必針對個別圖像，故是快

速處理 X3F 圖像檔案的方法。你不可以更改個別的檔案名稱；同
時，處理所有圖像檔案也需要使用相同的設定。不過，假如你選

取 “自動修             
正設定”；SIGMA Photo Pro 會以最佳化方式，處理每幅圖像。 

 
處理圖像群組的步驟如下: 

1) 選取資料夾內，包含了需要處理的 X3F 圖像檔案。 
2) 你可以處理整個資料夾內的圖像、選取某些圖像或已標記的圖像。 
3) 選擇或標記所需之預視圖片。 
4) 按上 Save Images As 按鈕。 

 
對話匣會顯示如下: 

 
 
 
 
 
      
 
  

  

  

  

  

  

  

  

  

  

從數碼相機，直接處理圖像及儲存到電腦 

從數碼相機內，將 X3F檔案轉換成為 TIFF 或 JPEG 檔案到電腦；這種直接處理和儲存圖像型式，
是一種極其快捷的方法。如在 CF記憶卡內，你只是刪除 X3F檔案，卻沒有轉移到電腦的話；便會
損失了一些優點；例如: 處理圖像可以使用不同的設定、解像度或檔案類型等。但是假如用戶在未
來，根本不需要處理圖像，又或電腦的儲存資源不足的話，你便需要從數碼相機，直接處理圖像
了。 

來源地:  

按上比率按鈕，並選取圖像群。 

修正模式: 

要更改圖像，請選擇 修正模式 。 

 

處理選項:  

請選擇 檔案輸出類型   

 解像度  
 色彩空間  

 
目的地: 

按上 Choose 按鈕；可選擇圖像檔案處理

後之目的地。  

按上OK  可開始處理和儲存；或 按上Cancel 
會回到主視窗。 
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77..22  在在檢檢視視視視窗窗處處理理圖圖像像  

處理個別圖像  

在檢視視窗處理圖像，就像在主視窗一樣，並附加以下優點: 
 

• 當你檢視圖像時，其實有不少處理程序，已經辦妥。因此儲存的速度會較快捷。 
• 你可以重新命名那些已儲存的圖像檔案。 
• 你可以利用 “修正控制調色板” 以修改設定。 
• 你可以在選取不同設定後，便可檢視圖像的詳細資料。 

 
 

當你想處理已選擇的圖像，按入 Save Image As 按鈕。 
 
 

對話匣會顯示如下: 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

應用未被儲存設定  

除了 “自動”、“預設”和 “已儲存設定” 外；你可以選取 “未被儲存設定”，並處理圖像。如你不打算
儲存此種設定的話，這方法的確可以幫到你。 
 

選擇目的地 

當你由來源地資料夾轉移及處理X3F圖像檔案後，那些圖像檔案仍會留在該來源地資料夾內；但
如你將圖像處理後，是不必將圖像留在來源地資料夾的。 
 
 

來源地: 

此項目會紀錄及顯示，圖像的檔案名稱和原

始解像度；這些資料不能被更改。 

修正模式: 

選擇修正模式 後，圖像處理過程
會被反映於此。 

 

處理選項:  

請選擇 檔案輸出類型   

 解像度  

 色彩空間  
 

目的地: 
按上 Choose 按鈕；可選擇圖像檔案處理後

之目的地。而且可以將圖像重新命名。  

按上OK  可開始處理和儲存；或 按上Cancel 

會回到主視窗。 
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77..33  處處理理選選項項  

要處理圖像，可使用移動選單和比率按鈕，並選取處理設定。而主視窗的 “Save Image As” 對話匣
和檢視視窗的 “Save Images As”  對話匣是完全獨立的。 
 
 

 

 

 

 

 

 

 

處理選項 (Processing Options) 

 

 

 

 

 

 

 

 

檔案類型 

SIGMA Photo Pro 及 Adobe Photoshop Elements  皆可支援 8-bit TIFF、16-bit TIFF、和 JPEG 等 
圖像檔案。如需要進一步有關圖像檔案資料，請參閱  章節 10.1。 

解像度  

軟件預設的解像度和數碼相機內之設定(High, Medium, or Low) 是一樣的。在軟件中，你也可以在
處理圖像時，選取 1 ½ 或 雙倍的解像度 (在每 … 中，1 ½ 或 雙倍數字的像素) 如需要進一步有關圖
像檔案資料，請參閱  章節 10.2。 
 

修正設定 

在這設定裡，有3 種選項 : 預設  - 使用內置在數碼相機的設定， 自動  - SIGMA Photo Pro 的自動化
修改，和 自定 – 由用戶自定。如需要有關如何設定的資料，請參閱  章節 6.5。而如需要有關儲存
設定的資料，請參閱  章節 8.6。 
 

色彩空間 

根據輸出所需，例如: 其他軟件、印表機和用戶收到的色彩數據；可選取適合的色彩空間。如你沒
有特殊的色彩管理指示，我們推薦你使用個人電腦或麥金塔電腦內的色彩空間。要作進一步的特殊

色彩管理，你在移動頁面上，根據你所需要的再選取其他色彩空間。如你想在移動選單中，加上額

外的 ICC 簡要；請參考系統所提供的使用文件。   

檔案輸出類型 

• 8-bit TIFF 

• 16-bit TIFF 

• JPEG 
 

解像度 
• 與原始尺碼相同 
• 一半尺碼 
• 雙倍尺碼 

 

修正設定 (Adjustment Mode) 

• 預設 
• 自動 
• 用戶自行設定 

 

色彩空間 
• 個人電腦標準色彩 
• 麥金塔電腦標準色彩 
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88   圖圖 像像 修修 改改

 

在此章節中，你會學到 … 
 
 

• 如使用修正控制調色板。 
 

• 如何修改色澤。 
 

• 如何修改色彩。 
 
• 如何使用矩形圖。 
 

• 如何圖層設定。 
 

• 如何儲存設定。 
 

• 如何刪除儲存設定 
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88..11  使使用用修修改改控控制制，，以以手手動動方方式式修修正正圖圖像像   

修正控制容許利用手動方式更正設定，並在檢視視窗中修正圖像。在 自定模式 裡，可於檢視視窗
更改任何控制。 在移動選單上可選取 “Current Unsaved Setting” ；這樣便可以利用手動方式修正圖
像。  
 
直至你選取其他模式或儲存了設定，在綜合檢視視窗中，現存的設定都會被每個圖像所應用。 當
開啟多重檢視視窗時，調色板的設定會反映在最前的檢視視窗上。 
  

開啟和關閉修正控制調色板 

 
開啟修正控制，在檢視視窗，按上 “Adjustment Control”。 
  

 
 

  
                

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

最大化、最少化和關閉調色板 

在修改控制調色板內，可將面板變成最大化或最少化。而在右上方角落中，按上灰色按

鈕，便會顯示 4個面板: 修正控制 (Adjust Controls)、色彩修正 (Color Adjustment)、 
矩形圖 (Histogram) 或 修正模式 (Adjustment Mode)。 

  
在修改控制調色板的右上方角落中；按上關閉匣，便可關掉所有調色板。而關閉所有檢視

視窗後，調色板也會跟著關閉。 

修正模式p.38 

使用此選項可設定修改模式、儲存和刪除指定的修正設定。 

 

矩形圖 (Histogram) p.36 

使用此選項可分析光暗度及確保色澤度可被組成。 
 

色彩修正p.34 

使用此選項將圖像色彩中和及修正全部色彩。 

 

色澤修正p.33 

使用此選項修改全部色調和色彩飽和度。 
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88..22  色色澤澤修修正正  

利用滑球方式，可控制曝光補償、光暗度、陰影、覆蓋和色彩飽和。如要檢視滑球面板，可在畫面
上的修正控制調色板，按上按鈕便可放大色澤修正。  

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

曝光 

這設定是可以利用 曝光補償的調較，修改圖像的光暗值。在滑球面板上，每 1/10 增幅便代表  
1/10光圈值 ( f/stop)。曝光補償的滑球面板上是可以相反方向移動的。 
 

對比 

這設定是可以利用對比的調較，修改圖像的黑白對比值。當增加時，白色會較光和黑色僧轉黑；如
減少時，黑白色都會變較灰。對比的上下數值是 –2.0 to 2.0。 
 

陰影 

這設定是可以利用陰影的調較，修改圖像的陰影值。當增加數值時，陰影會轉淡；如減少數值時，

陰影會轉黑。陰影的上下數值是 –2.0 to 2.0。 
 

覆蓋 

這設定是可以利用覆蓋的調較，修改圖像的覆蓋值。當增加數值時，覆蓋會轉光；如減少數值時，

覆蓋會轉黑。覆蓋的上下數值是 –2.0 to 2.0。 
 

色彩飽和 

這設定是可以利用色彩飽和的調較，修改圖像色彩飽和的值。當增加數值時，色彩會變得豐富；如

減少數值時，色彩會變的得單調。色彩飽和的上下數值是 –2.0 to 2.0。最低的色彩飽和值是 –2.0； 
可配合灰階(黑白)圖像。 
 
銳利度  
這設定是可以利用銳利度的調較，修改圖像的銳利度。當數值越大，銳利度越高。銳利度的上下數

值是 –2.0 to 2.0。

按上Reset 按鈕，便可回復設定到

預設狀態。 

按上箭頭按鈕，便可以1/10的增幅，

更改設定。 

可在滑球面板上，將數字按鈕按入和拖曳；
便可更改設定。 

按上按鈕可開啟和關閉滑球面板。 
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88..33  色色彩彩修修正正  

使用 “色彩修正” 可修改所有圖像的色彩。舉例說明: 如圖像因室內光源變得比較近黃色；當加入藍
綠色和紫紅色時，黃色便會被轉化變得較淺色。 
 
你可以手動方式使用 “色彩之輪” ，來修改色彩；請用滑軸來控制不同效果，或 在一個色彩中和，
但 RGB值並非中和的範圍內，收集了樣本；便可利用色彩修正點滴器，自動將畫面色彩中和。 
 
要檢視 “色彩修正輪” ；在畫面先開啟修正控制調色板，然後放大色彩修正面板。 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

使用色彩之輪  

 
按上和拖曳目標環到顏色圈的任何一處；當你移動到色彩之輪的邊緣時，圖像的顏色在該範圍內會

變得比較鮮艷。 而當離開了顏色圈，目標環亦會消失，而你便可繼續尋找所須修改之顏色。 
 
要回復到預設的原始設定，請按入 Reset 按鈕。 

 
 

 

 
 

 
 
 
 
 
 
 

按此按鈕，可開啟或關閉 
“Color Adjustment” 面板。 
 

按上 Reset 按鈕，便可便可回復設定到

預設狀態。 
 

藍綠色、紫紅色和黃色等色彩值，已被顯示在色彩修正過濾單位 - “CC”  

(color correction filter units) � 即是利用目標環，便可作色彩修改。 

點滴器按鈕  
 

增加額外的原色 (紅、綠或藍)
減少補充的色彩 (藍綠色、紫紅色和

黃色)

 

增加負值的原色 (藍綠色、紫紅色和黃色) 

減少補充的色彩 (紅、綠或藍) 
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使用色彩之輪，以手動方式修改色彩  

如室內燈光令畫面變得暗黃；以手動方式便可中和色彩的深淺。在檢視視窗中使用放大鏡 ，於中
和的灰色範圍內，抽出樣本。在放大鏡上根據 RGB值，拖曳目標環到色彩之輪上，便可設定 CMY
值來平衡RGB 值。當色彩樣本被中和後，其他圖像的色彩亦會保持平衡。 
 
目標環的數值，正代表了色彩之輪上，藍綠色、紫紅色和黃色等紀錄單位，皆顯示以 色彩修正過
濾單位 “CC” (color corre ction filter units)。在前頁的圖表指示著不同顏色 (紅、綠、藍、藍綠色、紫
紅色和黃色) 相互的關係。  
 
如你覺得整幅圖像的色彩較淺，但又沒有取得色彩的樣本時；拖曳目標環到所需顏色之地方便可中
和。舉例說明，假如圖像顯示色彩太紅，請將目標環拉到藍綠色上；即是色彩之輪上，紅色的相反

方向。 
 
 

使用色彩修正點滴器以修改顏色  

 
在SIGMA Photo Pro 中，如要於圖像裡產生灰階；可使用色彩修正點滴器。在檢視視窗上
選取圖像所需部份；按入色彩修正點滴器的按鈕。滑標便會變為點滴器圖示。  
 

 
 
 
 
如你在檢視視窗，使用放大鏡觀看圖像；在色調範圍內，RGB數值之間的數字，於修正後會大致
相同或相近。  
 
如你想使用不同的樣本，重新將平衡灰色；請按上點滴器按鈕，並重覆上述步驟。 
 
如你不喜歡色彩修正後的結果；請在面板底部按上 Reset  按鈕，便會回復到預設設定。你也可使用
點滴器在基礎上修改及在色彩之輪上移動目標環，並重新設定修正。 
 

將點滴器放置在顏色上並按鈕進入；軟件會評估樣本和作

出修正以令色澤中和。你也可按入和拖曳擷取色彩器；而
軟件會繼續試驗，直至滑鼠移開為止。 
 

當你按上色澤區，按入點滴器按鈕便會

回復成為原來的放大鏡或滑標。  

 
參考上述例子，灰色方格的顏色，在紅

色方面比較暗；當使用色彩平衡後，紅
色數值由93 上升至101；同時灰色亦顯

現較佳色調。 

修改後 

修改前  
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88..44  使使用用  矩矩形形圖圖   ((HHiiss ttooggrraamm))  和和  遮遮蓋蓋提提示示  

閱覽 矩形圖  (Histogram) 

要觀看矩形圖，在畫面上顯示修正控制調色板 及開啟矩形圖 (Histogram)  面板。 
 
 

 

 

 

 

 

 

 

 

 

矩形圖主要顯示出圖像的光暗分配。有3 種顏色線來描述紅色、綠色和藍色的光暗度。在檢視視窗 
亦會將 RGB 數值顯示在右下方上。  
 
陰影數值被顯示在面板的左方，中度色澤被放置在中央，而覆蓋數值被安放在面板右方。以上數值

比率的量度單位，會以 0 (最黑陰影) 至 255 (最白覆蓋) 來顯示。  
 
 

在遮蓋提示選擇使用、不使用和數值設定 

如要開啟和關閉圖層提示，請按入在矩形圖面板下方的標記匣。當陰影和覆蓋數值跌破特定數值

時；你是可以在之前先設置遮蓋提示來提醒自己。 
  
舉例說明: 當陰影數值在 8 以下時，你也許會發覺你的印表機或顏色條等不能提供較佳的陰影描
繪；同時如覆蓋數值高於240
也出現相同情況。根據這資

料，當數值超過以上限制，

你可以設置曝光圖層提示來
提醒自己。要設定限制，在

矩形圖按上箭頭按鈕更改設

定，直至調整到適當數值為
止。 
 
當你要設定圖層的數值；直

至圖層功能被重置或消除，

在此之前，你可以手動方式

在修正控制調色板上利用滑
球更改設定。 
舉例如下: 在檢視視窗內使用
提示。這樣強力的功能可協

助你優化完成品。 
 
  

按上此按鈕，可開啟和關閉

矩形圖 (Histogram)面板。 

 

按上箭頭按鈕，可設定遮蓋提示內
的陰影和覆蓋數值。 
 

如要開啟和關閉遮蓋提示， 
請按入標記匣。 
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88..55  修修改改白白平平衡衡   

在 X3F檔案中更改白平衡 

在圖像處理途中，白平衡是可以被修改的。如你想更改指定圖像的光度類別，你可以在 SD9 數碼
相機上更改光度類別，以符合不同性質的光源。如要修改白平衡，請先在檢視視窗內選擇圖像。接

著在檢視視窗上的選單，選取 Edit -> White Balance 。跟著對話匣便會出現如下: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
白平衡現有的設定會顯示在輸入的位置上。而在移動選單裡可以選擇不同的白平衡設定。假如用戶

需要進一步有關白平衡設定的資料；請參閱SD9數碼相機的使用說明書。 
 
當你選取不同的白平衡設定後，X3F 原始圖像檔案亦會被更新。但是請注意，在主視窗上的預視圖
片和在檢視視窗上的預視圖像是不會顯示修改後圖像的。白平衡的新設定是會在圖像處理時同步進

行；而效果則會在處理完成後，於檢視視窗顯現出來。 
 
每次你選擇了不同的白平衡設定後，新設定便會自動儲存在X3F 檔案裡。 如要觀看修改後的效
果，請等待圖像處理完成。 
 
當你在存取編輯(Edit)選單時，但被設定為 “不可用”時，請檢查儲存X3F 檔案的地方。如圖像檔案
被設定成唯讀檔案；但你要將 X3F檔案修改白平衡的話， 請先更改檔案屬性。 
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88..66  儲儲存存和和套套用用自自行行設設定定   

在修正控制調色板套用設定 

如要觀看修正模式 (Adjustment Mode)；先在畫面顯示修正控制調色板，然後開啟面板上的  
修正模式 (Adjustment Mode)。 
 
在修正控制調色板上的修正模式設定，會顯示圖像資料，而且和檢視視窗上的一樣。參閱 25頁    
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 

儲存設定 

 
要在修正模式調色板儲存現有設定，請按入在修正模式面板上的 Save Setting 按鈕 。之後 Save 
Setting 的對話匣便會出現。  
 
請在輸入欄內鍵入新設定的名稱。要更新現存已儲存的設定，請按入你想更新的設定名稱。. 

 

刪除設定 

 
要刪除儲存設定，請按入位於修正模式面板下方的 Delete 按鈕。之後 Delete Setting 對話匣便會出
現。  
 
請按入你想刪除的設定名稱，然後按上 Delete按鈕。 
 
 
 

 

  

按入按鈕，可開啟和關閉修正

模式面板。 

按上Save setting按鈕；可在修正模式面
板內儲存現有設定。按上 Delete setting  

按鈕；可刪除不要的設定。 
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99   取取 得得 圖圖 像像 資資 料料

 

在此章節中，你會學到 … 
 
 

• 如何在主視窗和檢視視中尋找
圖像。 
 
• 如何開啟在圖像資料視窗內的
額外資料。  
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99..11  圖圖像像資資料料  

在主視窗和檢視視窗上的圖像資料 

 
當主視窗上的圖像被選擇時；同時，圖像的基本資料也會於預視面板上的資料欄內顯示。但當你選
擇了多重圖像時，主視窗上的資料欄便會變成空白。 
 
資料包括: 

• 檔案名稱 
• 圖像的日期和時間 
• 鏡徑和快門速度 
• 感光度(ISO)及解像度 
• 檔案大小 (MB) 

 
在檢視視窗也同時顯示以上相同的圖像資料。 
 

在顯現文字資料同時；標記、鎖定和轉移等狀況也會在單一圖像的資料欄上顯示。
假如TIFF 或 JPEG 等檔案是在其他軟件上處理的話，只會顯示檔案類型和鎖定狀況
等資料。 

 
 
 

在預視面板上的圖像資料  

 
被選擇圖像的資料是顯示在主視窗內預視面板的下方的資料欄上。此欄會指示被選擇圖像的數量和
它們檔案大小的總和。  
 

在數碼相機和電腦面板上的圖像資料  

 
和上述一般，圖像資料也會顯示在數碼相機和電腦面板下方。此欄會

指示在資料夾內圖像的數量和它們檔案大小的總和。  
  
 
 
 
 
 
 
 

 

  
圖像資料欄 
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  99..22    存存取取圖圖像像資資料料視視窗窗  

 

 
 
 

圖像資料按鈕  

在主視窗或檢視視窗中，按上圖像資料按鈕；便可觀看個別或群組圖像的資料。 
 
 

圖像資料視窗  

在主視窗和檢視視窗中，圖像資料視窗是將圖像資料顯示出來。請參閱圖像資料視窗例圖如下；視

窗顯示數量的多寡，視乎選擇圖像多少而定。 
 
  
  
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
請按入檢視視窗內包含的新圖像或在主視窗的新預視圖片；便可取得不同圖像的資料。當選擇不同
圖像，圖像資料視窗上的資料便會版更新。 
 
在主視窗和檢視視窗關閉前；或登出軟件前，圖像資料視窗會仍然開啟。如要在 SIGMA Photo Pro 
開啟狀態中，關閉圖像資料視窗；請按入標題絛上的 Close 符號:或在視窗下方的Close 按鈕。 
 
 

如用戶要複製圖像資料視窗上的文字；請按入 Copy to Clipboard 
按鈕。 然後在任何文字處理軟件裡，將文字貼上。你便可以使用
它們的列印功能，將文字打印出來。如你想在 SIGMA Photo Pro

儲存圖像資料，以方便日後處理的話；十分抱歉，SIGMA Photo Pro 暫不能使用此功能。但你仍然
可以開啟文字檔案，並在文字處理軟件裡，將內容打印出來。
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11 00   附附 件件

 

在在此此章章節節中中，，你你會會找找到到  …… 
 
 

• 軟件的附加資料。 
 

• 數碼相機的附加資料。 
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1100..11  支支援援之之檔檔案案類類型型   

TIFF 圖像檔案 

TIFF (Tagged Image File Format) 這是一種高質素的圖像格式，並已廣泛地被不同軟件所使用。這檔
案類型是一種工業標準，是不經色彩壓縮而形成的。非壓縮圖像的檔案容量是很大的；但如用戶需

要高品質和不用色彩壓縮的話，這是最佳選擇。 
 

8-bit 對 16-bit TIFFs 

在圖像裡，每點像素內 bits 的數目是代表著圖像內一連串可容納的數值。龐大的 bit-depth直接影響
圖像檔案的大小；因為當擁有越高的色彩範圍，而 bit-depth也增大，同時模糊和鬆散化等現象便會
越小。而16-bit 的 TIFF檔案所需之記憶體也是 8-bit TIFF檔案的兩倍。 
 
當在選取16-bit 的圖像檔案前，請檢查一下輸出系統和圖像軟件是否可支援 16-bit TIFF的檔案。假
如你未打算利用Photoshop 等較高階的軟件處理圖像；基本上，8-bit 的TIFF檔案其實已經足夠給
用戶使用。 
 

JPEG 圖像檔案 

JPEG 圖像是一種已被色彩壓縮的圖像檔案，已廣泛在網上和電郵傳遞之間使用；其好處在於檔案
容量較小和便於流通。此類檔案是以色彩壓縮來減低圖像檔案的容量大小。而透過SIGMA Photo 
Pro，你可以在儲存圖像時，調校其壓縮比率。但當隨著壓縮比率趨向較大時，圖像色彩的質素便
同時傾向模糊和鬆散。 
 
JPEG檔案是網站們的恩物；因為其檔案容量較小，方便在網站上傳閱。在沒有減低解像度的情況
下，儲存成為 JPEG檔案令圖片可以更快速度顯示在畫面上。但如用戶需要列印高品質的輸出品；
JPEG格式就未必可以滿足閣下要求了。 
 
如你在 Photoshop Elements 裡反覆修改 JPEG圖像，那些 JPEG圖像是會有一些不良效果累積在其
中。在此說明，每次 JPEG圖像被多次修改、儲存和關閉的同時，也會有一些質素損失在壓縮程序
之中。 
 

決定使用哪種圖像格式 

JPEG 圖像檔案是一種擁有高顯示效率和能被快速產生的格式。實在地，請保留一個X3F檔案的副
本。假如檔案用途是在網上顯示和電郵之間傳遞，便可另存新檔成為 JPEG檔案。之後，如需要以
高品質列印的話，請以 X3F檔案為本；另存新檔成為 TIFF 檔案。 

  

1100..22    選選取取解解像像度度   

選擇不同的解像度  

解像度就是在圖像內，每英寸內所有之像素。所以當圖像的像素有多大時，輸出到印表機或顯示器
便會有多大。第一，因為印表機在列印時是需要多一些像素的(原則上是300 ppi 或以上)；故此如要
列印圖像，在之前便要先調整像素圖像至較大。第二，因為顯示器只需較低的像素便已足夠 (原則
上是 72 to 96 ppi)，故此如圖像只是 在網上顯示和電郵之間傳遞的話，便只選擇低像素就可以了。 
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1100..33  數數碼碼相相機機參參考考  

數碼相機的日期和時間設定 

你可以將數碼相機的日期和時間設定和電腦相配合。請先確定電腦上的期和時間是準確的。 然後
到設定數碼相機的日期和時間；先將數碼相機連接到電腦，並開啟數碼相機。請參考主視窗的選單

如下: 
 

Camera -> Set Camera Date and Time 
 

 
當選用此功能後，便會出現以下對話匣。按上 OK 後便已完成日期和時間設定。按上 Cancel 便取
消以上活動及離開；而數碼相機的日期和時間設定會維持不變。 
 

 
 

 

電池提示 

保持充足電源是一件重要的事；因此廠方建議用戶，當數碼相機連接上電腦時，請接上AC電源以
避免圖像檔案流失。 提醒一句，當你使用電池時連接上電腦時，在數碼相機上的電池圖示會定時
轉為紅色。這是電池使用中的提示；但並不代表電池用罄。 
 
數碼相機的電池電量流失，可以是迫切或漸進的。 即是說，當 SIGMA Photo Pro 偵測到你的數碼相
機是低電量時；你或會不時看到以下的對話匣顯示出現。 
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IInnddeexx  

A 
Adjustment Controls Palette …………….…32………………..修正控制調色板 
Adjustment Modes …………………………25………………..修正模式 
 Default ……………………………….…25………………..預設 
 Auto……. ………………………………25………………..自動 
 Custom………………………………….25………………..自行設定 
Auto-Launch  ………………………………12………………. 自動執行 
Auto Mode …………………………………25………………..自動模式 
 
C 
Camera…………………………………..11,44……………….數碼相機 
 Battery warning …………………………44..……………..電池提示 
 Connecting  ………………………………11………………連接 
 Setting date and time… …………………44………………日期和時間設定 
Color …………………………………….34-35………………色彩 
 Adding and removing  ……………… 34-35………………加上和移除 
 Adjusting  ……………………………34-35………………修改 
Contrast ………………………………… ..…33..……………..對比 
Copying Images  …………………………….14…..…………..圖像複製 
Color Space …………………………………30..……………..色彩空間 
Color Wheel ………………………………...34…..…………..色彩之輪 
Custom Mode ………………………….……25…..…………..自定模式 
 
D 
Default Mode ……………………………….25…..…………..預設模式 
Deleting Images ………………………….…20………………圖像刪除 
 
E 
Exposure Compensation ……………………33….……………曝光補償 
 
F 
File Type ………………………………..30, 43………………..檔案類型 
 
G 
Gray Balance ………..…………………..34-35……..…………灰階平衡 
 
H 
Highlight control ……………………………33………………..覆蓋控制 
Histogram ……………………….…………..36…………..…….矩形圖 
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I 
Image Information Window ……………..…41……………….圖像資料視窗 
Images ……………14,19, 20, 28-30, 31-36, 41……………….圖像 
 Adjusting ……………………………31-36.……………….修改 
 Copying …………………………………14….……………複製 
 Deleting …………………………………20……………….刪除 
 Information  ……………………………... 41………………資料 
 Locking ………………………………….20……...……….鎖定 
 Marking …………………………………20….……………標記 
 Processing ……………………………29-30………………處理 
 Renaming ……………………………….19………………..重新命名 
 Resolution  ……………………………….30……………….解像度 
 Rotating …………………………………20……………….旋轉 
 Saving ………………………………..28-29……………….儲存 
 Selecting …………………………………19….……………選取 
 Installing SIGMA Photo Pro ……………..7……………….安裝 SIGMA Photo Pro 
 
J 
JPEG image …………………………………43……….………JPEG 圖像格式 
 
L 
Locking Images ……………………………..20………..…..…圖像鎖定 
 
M 
Magnification Loupe  ……………………23-24…….…..…….放大倍率 
Main Window …………………………………3…….…..…….主視窗 
Marking Images …………………………..…20…….…..…….圖像標記 
Monitor  …………………………………….7, 9…….…..…….顯示器 
 Resolution  ………………………………7, 9…….…..…….解像度 
 Verification   ……………………………….9…....…………確認 
 
N 
Navigation Pane …………………………..…17…….…..…… 瀏覽方框 
 
P 
Processing and Saving Images …………..27-30………..……..列印 
       Processing Groups of Images …………..28………………處理一組圖像 
       Processing Individual Images …………..29………………處理單張圖像 
 
R 
RGB Values ………………………………...34………………RGB數值 
Renaming Images …………………………..19………………圖像重新命名 
Resolution ……………………………….….30………………解像度 
Review Window …………….…………….…4……………….檢視視窗 
Rotating Images  …………………………….20……..………..圖像旋轉 
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S 
Saturation control  ……………………………33……….……色彩飽和控制 
Saved Settings ………………………………..38……….……儲存設定 
Saving Images……………………………..28-29…………….圖像儲存 
 For Print …………………………………..43……….……列印用途 
 For Web …………………………………..43……….……網頁用途 
 Saving Groups of Images………………….28…………….儲存一組圖像 
      Saving Individual of Images………………29……………儲存單張圖像 
Selecting Images ………………………………19……………圖像選取 
Settings……………………………………25, 38…………….設定 
 Saving……………………………………...38……………儲存 
 Deleting……………………………………38…………….刪除 
Shadow control ……………………………….33…………….陰影控制 
Software………………………………….7-8, 12…………….軟件 
 Auto-Launch………………………………12…………….自動執行 
 Installation ………………………………….7.…………….安裝 
      Driver………………………………………8…..…………驅動程式 
 Removal…………………………………….7…………….移除 
 System requirements………………………..7…………….系統需求 
 
T 
Thumbnail…………………………………….18….………… .預視圖片 
 Filtering……………………………………18……………. 過濾 
 Size………………………………………...18…………….尺碼 
 Sorting……………………………………..18…………….分類 
 Viewing with Details ………………………18……………. 觀看詳細資料 
Thumbnail Pane……………………………….16…….………預視方框 
TIFF image…………………………………….43…………….TIFF 圖像 
Tonal Adjustments…………………………….33……………..色澤修正 
       Contrast……………………………………33……………..對比值 
       Exposure compensation…………………..33……………...曝光補償 
       Highlights…………………………………33……………..覆蓋度 
       Saturation…………………………………33……………. 色彩飽和 
       Shadows…………………………………..33………… …. .陰影值 
 
W 
Warning Mask…………………………………36…………….遮蓋提示 
White Balance…………………………………37……………. 白平衡 
 
X 
X3F image…………………………12, 14, 17, 19……………...X3F 圖像 
 
 
 
 
  

  


